REN ESAS Application Note

Renesas RA Family

"GUIX Thermostat"” for EK-RA8D1 MIPI Display

Introduction

This application, which is a Thermostat application, provides a reference for developing complex multi-
threaded applications with a touchscreen graphical Human Machine Interface (HMI) by using Renesas FSP
and Azure RTOS GUIX. It describes steps to create a basic GUIX for FSP, integrates a touch driver, and
handles multiple hardware accesses, system updates, and event handling.

This application is developed using the Renesas RA Flexible Software Package (FSP), which provides a
quick and versatile way to build secure connected Internet of Things (IoT) devices using the Renesas RA
family of Arm microcontrollers (MCUs). RA FSP provides production-ready peripheral drivers to take
advantage of the RA FSP ecosystem along with Azure RTOS GUIX library and Azure RTOS.

This application note assumes that you are familiar with the concepts associated with writing multi-threaded
applications under a Real-Time Operating System (RTOS) environment, such as Azure RTOS. This
application note makes use of RTOS features such as threads and semaphores. Prior experience in using
Azure RTOS would be helpful for easy understanding of the provided application project. For more detailed
information on Azure RTOS features, refer to the Azure RTOS User Manual.

The Graphics application is developed using the Renesas e? studio Integrated Solution Development
Environment (IDE). e? studio is integrated with the FSP platform installer, which can be downloaded from the
Renesas website. The intuitive configurators and code generators in e? studio and FSP will help the
application developers create complex multi-threaded graphics applications very quickly. This application
note walks you through all the necessary steps in creating, building, and running a complex graphics project,
including the following:

Board setup.

Install tools.

Build and run applications.

Azure RTOS GUIX Studio project integration.

Setup Azure RTOS GUIX Studio project.

Add touch Driver.

Create FSP GUIX project.

Hardware Setup.

Using the General Purpose Timer to drive a PWM backlight control signal.

e o o o o o o o o

Required Resources

Development tools and software

+ e studio IDE Version: 2024-07 (24.4.0) or greater
* Renesas Flexible Software Package (FSP) v5.5.0.
* Azure RTOS GUIX Studio V6.4.0.

Hardware

* Renesas EK-RA8D1 kit (RA8D1 MCU Group)
- MIPI LCD included.
- Micro USB cable included.

Reference Manuals

* RA Flexible Software Package Documentation Release v5.5.0
* Azure RTOS GUIX and GUIX Studio v6.4.0.0

* Azure RTOS ThreadX v6.4.0

* Renesas RA8D1 Group User's Manual Rev.1.1.0

* EK-RA8D1-v1.0 Schematics
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

Purpose

This document will guide you through the setup of an Azure RTOS GUIX touchscreen interface Thermostat
application in e? studio. This document will show how to configure the drivers and library included with the
FSP. These will allow you to set up the MIPI LCD Display Controller, the LCD’s touch screen drivers, and
RTOS objects to communicate with application tasks. It also shows the steps necessary to create a simple
GUl interface using the Azure RTOS GUIX Studio editor. In addition, this app note will cover project setup
along with basic debugging operations. When it is running, the application will respond to touchscreen
actions, presenting a basic graphical user interface (GUI).

Intended Audience
The intended audience is users who want to design GUI applications.
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

1. Download and Installing Tools

1.1 Overview

In this section, you will copy the application note (AN) materials to your PC and install e? studio
v2024-04/FSP v5.5.0 and Azure RTOS GUIX Studio v6.4.0.0.

1.2 Procedural Steps

1.2.1 If you already have e? studio with FSP v5.5.0 or later installed, you can skip this step. Otherwise, you
can download it from this link.

1.2.2 You can get Azure RTOS GUIX Studio v6.4.0.0 or greater from this link. If it goes well, you will see
the window in the next step on the web browser.

Note: Microsoft Store needs to work on your PC to install Azure RTOS GUIX Studio.

1.2.3 Click Download to local PC and start installing Azure RTOS GUIX Studio.

5!; Microsoft l Store Home Apps Games Entertainment About L Search apps, games, movies, and more B Open Store app

Azure RTOS GUIX Studio

Microsoft Corporation

50% 2 ratings Developer tools

Figure 1. Get Azure RTOS GUIX Studio

1.2.4 Either you will be directed to the Microsoft Store for installation, or a .exe file will begin downloading.
If the latter, click the downloaded file “Azure RTOS GUIX Studio installer.exe” and continue to
install Azure RTOS GUIX studio.

ﬁ Azure RTOS GUIX Studio Installer.exe
Figure 2. Install Azure RTOS GUIX Studio

1.2.5 Click “Open” to open the “Azure RTOS GUIX Studio” App.

ﬂ Microsoft Store X

Azure RTOS GUIX Studio

Microsoft Corporation

50 W (J Privacy &terms ([J More details
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'@1 Azure RTOS GUIX Studio 64.0.0 - 0O x

Project Edit Insert Configure Help
L a ¥ L] o = =l v [ & W = [ u.

T, Project View -

Mo Project

FE Properties View -

Figure 3. Click Open to Launched “Azure RTOS GUIX Studio”.
1.2.6 Close Azure RTOS GUIX Studio for now; you will need to open it again later.

2. Create the Application Project and Enable Backlight

2.1 Overview

In this section, you will create a project to which you will add pre-written source code and integrate it
with a pre-created Azure RTOS GUIX studio project.

2.2 Procedural Steps
2.21 Create a new RA C/C++ project. Name it Thermostat_GUIX_EK_RA8D1_MIPI.

€9 Welcome X | B oA
RENESAS Welcome to e2 studio »)
Hide
Create a new e? studio C/C++ project Get an overview of the features
‘ e
8 New C/C++ Project [} X B Renesas RA C/C++ Project O X
Renesas RA C/C++ Project _

Templates for New C/C++ Project
Project Name and Location

Renesas RA C/C++ Project
===~ (Create an executable or static library C/C++
project for Renesas RA. —-——I‘ Themostat_GUIX_EK_RASD1_MIPI ”

Project name

Use default location

You can download more Renesas packs here

@ Er o o @ <Back Next > Finish Cancel

Figure 4. Create New Project
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“‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.2 Set the board to EK-RA8D1.

a Renesas RA C/C++ Project

Renesas RA C/C++ Project

Device and Tools Selection

Device Selection

FSP Version: |5.5.0

Board Description

Board: | EK-RASDI

I Evaluation kit for RABD1 MCU Group

Visit https://www.renesas.com/ra/ek-ra8d1 to get kit

Device: R7FABD1BHECBD
Core: CM85

language: @C OC++

Toolchains

TrustZone Yes
Pins 224
Processor Cortex-M85
Debugger
N J-Link ARM v

user's manual, quick start guide, errata, design
package, example projects, etc.

Device Details

| 13.2.1.arm-13-7 b |

@

LLVM Embedded Toolchain for Arm

Manage Toolchains...

< Back | Einish Cancel

Figure 5. Select and Set board to EK-RA8D1

2.2.3 First, select the Project Type as Flat and click Next. Then, set the Build Artifact to Executable and
the RTOS to Azure RTOS ThreadX (v6.4.0+fsp5.5.0) and click Next.

D Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Type Selection

Project Type Selection

|_@ Flat (Non-TrustZone) Project |

® Renesas levice project without TrustZ]
e All code, data and peripheral settings wil|
in this project ‘
Renesas RA device will remain in secure
EDMAC RAM buffers will automatically bl
secure RAM

(O TrustZone Secure Project

® Renesas RA device project for TrustZone |

® All code, data and peripherals placed in 1
be initialized as secure |

® Secure project settings such as TrustZone
maps and a list of secure peripherals will
selected non-secure project |

e After initialization, a call to the non-secu
handler will be made

(O TrustZone Non-secure Project

® Renesas RA device project for TrustZone

execution

s All code, data and peripherals placed in{
be initialized as non-secure |
Must be associated with a secure project
Non-secure startup handler will be called
code initialization

Build Artifact Selection

[m] X
(3 Renesas RA C/C++ Project 0 X
Renesas RA C/C++ Project —<

Build Artifact and RTOS Selection

RTOS Selection

@ Executable | Azure RTOS ThreadX (v6.4.0+fsp.5.5 ~

® Project builds to an
executable file

(O Static Library
e Project builds to a static
library file
(O Executable Using an RA Static Li
® Project builds to an executable
® Proiect uses an existina RA stati

< Back Einish Cancel

<Back ||  Next> I Finish Cancel
- I

Figure 6.

Select Azure RTOS ThreadX
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.4 Use Azure RTOS ThreadX - Minimal template and click Finish.

& Renesas RA C/C++ Project O 4

Renesas RA C/C++ Project <

Project Template Selection

Project Template Selection

o d- Azure RTOS ThreadX - Blinky

Azure RTOS ThreadX project that includes BSP and will blink LEDs if
available. This project will initialize the MCU using the BSP. ThreadX
will also be initialized and a single thread to blink the LEDs will be
started.

[Renesas.RA.5.5.0.pack]

®© d° Azure RTOS ThreadX - Minimal

L. Empty ThreadX FSP project with no threads. This project will initialize
the MCU using the BSP.

[Renesas.RA.5.5.0.pack]

Code Generation Settings
Use Renesas Code Formatter

@ < Back Next = Cancel

Figure 7. Selecting Azure RTOS ThreadX — Minimal Template

2.2.5 Open the project’s configuration.xml file and go to the BSP tab. Use the Properties tab while in the
FSP Configuration View to view and edit the settings for the SDRAM to match the picture below.
Also set the Main stack size(bytes) to 0x2000 and the Heap size (bytes) to 0x2000.

%% *[Themostat GUIX_EK_RASD1_MIPI] FSP Configuration X = O | B outline | [T Properties <
; i o .
Board Support Package Configuration Cnerats ot Coptent EK-RABD1
" Prope Value
E3 Restore Defaul Seitinge i ::ckage,pms 224
v RASD1
Device Selection series 8
FsP version: [550 = Board Details v RABD1 Family
: Evaluation kit for RABD MCU Group v SDRAM
Board: EK-RABD1 - || gug - L v Timings
Device: R7FABD1BHECBD ‘ :(S‘L:s;r"si mg:n.w‘\.;i:i‘.q‘mck.;an glAu:d; *e'ra“t: dt:s;?\t iyt S
o = package, example projects, etc SRCD (oydles) 3anies
Core: CMES tRP (cycles) 3 cycles
- TWR (cycles) 2 cycles
RTOS: Azure RTOS ThreadX {CL (cycles) 3 cycles
RFC (cycles) 937
tREFW (cycles) 8 cycles
Initialization
SDRAM Support Enabled
Address Multiplex Shift 10-bit shift
Endian Mode Little Endian
Continuous Access Mode Enabled
Bus Width 16-bit
Security
OFS0 register settings
OFS1_SEL register settings
OFS1 register settings
OFS2 register settings
Block Protection Settings (8PS)
Permanent Block Protection Settings (PBPS)
First Stage Bootloader (FSBL)
Clocks
Cache settings
Enable inline BSP IRQ functions Enabled
Dual Bank Mode Disabled
Main Oscillator Wait Time 8163 cycles
~ RA Common
Main stack size (bytes)
Heap size (bytes) 0x2000
5 g MCU Ve (mV) 3300
Summary | BSP| Clocks | Pins  Interrupts | Event Links | Stacks| Components S Aieeties

Figure 8. Setting SDRAM, Main stack size and Heap size Bytes Properties
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

Note on GUI Storage in MCU’s Memory::

This project uses an Azure RTOS GUIX project that contains multiple full-screen pixel maps. Calculations for
the memory footprint of one image are given by: 1 image = 480 x 854 pixels x 24bpp / 8 = approximately 1.3
MB. This Thermostat_ GUIX_EK_RA8D1_MIPI project has multi-images stored in the code flash memory,
which is larger than 2 MB of code flash memory. It will overflow the region. The alternative is to use the
SDRAM to store the pixel maps. The SDRAM memory is available built-in on board (SDRAM is 512Mbit,
which is 64Mbyte). Following section 2 and Figure 12, step # 2.2.9 Settings properties for Graphics LCD:
“Input > Framebuffer > Section for framebuffer allocation > . sdram (it points to SDRAM and use SDRAM).
After step 2.2.30: Generate Project Content and Build Project”, you will see the SDRAM initialized through
the generated macro in hal_entry.c file BSP_CFG_SDRAM_ENABLED.

= #if BSP_CFG_SDRAM_EMNABLED

/* Setup SDRAM and initialize it. Must configure pins first. */
R_BSP_SdramInit(true);

#endif

Figure 9. SDRAM Initialization Macro

2.2.6 Click tab “Clocks” and set “Clocks” for the LCDCLK

49¢ [Themostat_GUIX_EK_RASD1_MIPI] FSP Configuration X ol = |

Clocks Configuration Generate Project Content

2 Restore Defaults

| -

»>PLL Src: XTAL i > ICLK Div /2 | —> ICLK 240MHz
HOCO 48MHz v PLLDiv /2 v PLL1P Div /2 ~ —> PLL1P 480MHz H [>/PCLKA Div /4 ¥ |—> PCLKA 120MHz
LOCO 32768Hz PLL Mul K96{!U EPLUQ Div /2 ~ —= PLL1Q 480MHz [ PCLKB Div /8 ~ |—> PCLKB 60MHz
MOCO 8MHz PLL 960MHz PLL1R Div /2 ~ —> PLL1R 480MHz > PCLKC Div /8 v |—> PCLKC 60MHz
SUBCLK 32768Hz PLL2 Disabled e "= PCLKD Div /4 w|— PCLKD 120MHz
PLL2 Div /2 o PLL2P Div /2 ~ —= PLL2P OHz > PCLKE Div /2 ~|—= PCLKE 240MHz
PLL2 Mul x96.00 J;FLLZQ Div /2 ~ — PLL2Q OHz SDCLK Enabled ~ |—> SDCLK 120MHz
PLL2 OHz ‘]’ PLL2R Div /2 ~—= PLL2R OHz > BCLK Div /4 ~|—= BCLK 120MHz
EBCLK Div /2 ~|—> EBCLK 60MHz
"> FCLK Div /8 ~ |—> FCLK 60MHz
CLKOUT Disabled ~ — CLKOUT Div /1 ~ |— CLKOUT OHz
SCICLK Disabled ~ —> SCICLK Div /4 “|—> SCICLK OHz
SPICLK Disabled ~ —>SPICLK Div /4 | —> SPICLK OHz
CANFDCLK Disabled  —= CANFDCLK Div /8 |—= CANFDCLK OHz
i’lCDCLK Src: PLLIP ~ — LCDCLK Div /2 ¥ |—> LCDCLK 240MHz
IBCCLK Disabled ~ —>3CCLK Div /3 ~|—= I3CCLK OHz
UCK Disabled ~ —=UCK Div /5 ¥ |—> UCK DHz
UBOCK Disabled ~ —>/U60CK Div /> ~ |—= U60CK OHz

OCTASPICLK Disabled ~ — OCTASPICLK Div /4  ~ —> OCTASPICLK OHz

Summary | BSP Clocks| Pins | Interrupts | Event Links | Stacks| Companents

Figure 10. Clocks Setting For LCDCLK

RO1AN7550EU0100 Rev.1.00 Page 8 of 46
Oct.15.24 RENESAS



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.7 Back in the Stacks Configuration tab, click add “New Thread”, name it System Thread, and set the

roperties as shown in the image below:

{5 *[Themostat GUIX_EK_RABD1_MIPI] FSP Configuration X = O || 8= outline| ] Properties x
= = o New Thread
Stacks Configuration Generate Project Content
Property Value

- Settings
Threads I % | New Thread | % | Remove |- % | New Stack > 1 ~ Common
System Thread Stacks 5 Gi I
~ & HAL/Common : i
. = Timer
% g_ioport /O Port (r_ioport) Add stacks to the selected thread by using the ‘New Stack’ Trace

Azure RTOS ThreadX Port (rm_threadx_port > lo_olnar button (above), or by pasting here from the e
& System Thread clipboard. =

Interrupts

~ Thread
Symbol system_thread
Name System Thread
Stack size (bytes) 8132
Priority 5
Auto start Enabled
Time slicing interval (ticks) 5

Figure 11. Adding the System Thread and setting its properties

2.2.8 With the System Thread selected in the Threads window, click Add New Stack > Graphics >
Azure RTOS GUIX.

{8h *[Themostat_GUIX_EK_RABD1_GLCD] FSP Configuration = 0O ||[T] Properties X
Stacks Configuration o New Thread

Generate Project Content
Settings Property

Threads ¢ |New Thread ® | Remove — - ~ Common
System Thread Stacks Al

T = % ? General
~ w0 HAL/Common : Analog > T
4 g_ioport 170 Port (r_ioport) Add stacks to the selected th Audio ? Trace
4 Azure RTOS ThreadX Port (rm_threadx_port) #'  Stack toolbar button (above Bootloader 2 Performance
@ System Thread the Klipboard. Connectivity ’ RA
DsP > | 5 Intermnts
I Graphics > 4 Agzure RTOS GUIX |
Input * & Capture Engine Unit (r_ceu)
Monitoring > & D/AVE 2D (r.dmw)
T ” @ D/AVE 2D Port Interface (r_drw)
Networking i 4 Graphics LCD (r_glcdc)
Power ¥
. Security > Time slicing interval (ticks)
Objects % | New Object > u Sensor 3
Storage ’
System »
Timers b
Transfer »
¥ Search..

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Components

Figure 12. Add Azure RTOS GUIX
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.9 Use the properties settings as illustrated in the images below for the Azure RTOS GUIX library, the
Azure RTOS GUIX Port (rm_guix_port) middleware, and the Graphics LCD (r_glcdc) module.

{5} *[Themostat_GUIX_EX_RA8D1_MIPI] FSP Configuration X = H
Stacks Conﬁgurltlon Generate Project Content
Threads & New Thread %] Remove =] mmeNewsuch =2 Extend Stack
v & HAL/Common 3] Remove
& g_ioport I/O Port (r_ioport)
@ Azure RTOS ThreadX Port (rm_threadx_port)
v g System Thread
&P Azure RTOS GUIX
ry
& Azure RTOS GUIX Port (rm_guix_port)
@
= Azure RTOS GUIX Port (rm_guix port)
@ o_display0 Graphics LCD | | 4% D/AVE 2D Port Interface gﬂﬂ; Property Value
(r_glcdc) (r_drw) ~ Common
ARlinto DRW Buffer Cache Enabled
@ @ v Module Azure RTOS GUIX Port (rm_guix_port)
Objects €] New Object > % ] Remove ? T w Display Rotation
%9 Add MIPI DSI Output & D/AVE 2D (.dw) Screen Orientation CW (90 degrees)
(Optional) Use Canvas Buffer Disabled
Canvas Buffer Memory Section sdram
@ » JPEG Decoding
Name g_rm_guix_port0
Target Display Layer Graphics Layer 1
Callback Function NULL
Summary BSP Clocks Pins | Interrupts Event Links| @ Stacks Components
TE} [Themostat GUIX_EK_RASD1_MIPI] FSP Configuration X = B |32 outline [ Properties X
Stacks Configuration Cena AR ot Conant g_display Graphics LCD (r_gledc)
?"95 Property Value
Threads % | New Thread %] Remove |- e el &) New Stack > = ck > m‘ ~ Common
v & HAL/Common % | Remove —____| Parameter Checking Default (BSP)
< y Color Correction Off
.‘: g foport YO Purk{jopord) & Azure RTOS GUIX v Module g_display Graphics LCD (r_glcdc)
4 Azure RTOS ThreadX Port (rm_threadx_port) + General
v & System Thread Name
4% Azure RTOS GUIX @ > Interrupts
? v Input
4" Azure RTOS GUIX Port (rm_guix_port) ¥ Graphics Layer )
~ General
Enabled Yes
0] Horizontal size 480
= Vertical size 854
— Horizontal position 0
+ D/AVE 2D Port Interface Vertical position 0
{E.dw) Color format
Line descending mode Disabled
@ v Framebuffer
- Framebuffer name fb_background
% Add MIPI DSI Output 49 D/AVE 20 (r_drw) HNumbefof Ta/metniifers 2
(Optional) Section for framebuffer allocation
> Line Repeat
@ > Fading
> Graphics Layer 2
v Ouiput
= = . = v Timing
S 2 Mew Obiact - N IS Horizontal total cycles 559
Horizontal active video cycles 480
Horizontal back porch cycles B
Horizontal sync signal cycles 2
Horizontal sync signal polarity Low active
Vertical total lines 894
Vertical active video lines 854
Vertical back porch lines 20
Vertical sync signal lines 3
Vertical sync signal polarity Low active
% % Data Enable Signal Polarity High active
snecos
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components > Format

Figure 13. Setting Properties of Azure RTOS GUIX Port
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.10 Left-click on Add MIPI DSI Output (Optional) > New > MIPI Display (r_mipi) to add the MIPI DSI
and Phy Output modules. Then, set the interrupt callback routine name for the MIPI Display (r_mipi_dsi) as
shown in the image below.

{0} *[Themostat_GUIX_EK_RABD1_MIPI] FSP Configuration X =]

Stacks Configuration Generate Project Content

@] New Stack > =% Extend Stack
System Thread Stacks
% | Remove

&) New Stack > =% Extend Stack

N
¥ | Remove

Threads & | New Thread # | Remove |-

System Thread Stacks

v -’? HAL/Common

-#ﬂ g_ioport I/O Port (r_ioport)

4 Azure RTOS ThreadX Port (rm_threadx_port)
~ & System Thread

47 Azure RTOS GUIX ® ®

4% Azure RTOS GUIX 4 Azure RTOS GUIX

4 Azure RTOS GUIX Port (rm_guix_port) 4 Azure RTOS GUIX Port (rm_guix_port)

@ 0]
A -
I I I I
4 g_display Graphics LCD 4 D/AVE 2D Port Interface 4% g_display Graphics LCD 4% D/AVE 2D Port Interface
(r_glcdc) (r_drw) (r_glcdc) (r_drw)
@ ® @ @
- ry ry ry
e —— e —
| | 4 D/AVE 2D (rdw) & D/AVE 2D (r_drw)
|
@ @
I e Iy
New > 4 mel Display (r_mipi_dsi) L
4 g_mipi_phy0 MIPI

Physical Layer
(r_mipi_phy)

@

{2 [Themostat GUIX_EK_RABD1_MIPI] FSP Configuration X | (& system_thread_entry.c [} hmi_event_handler.c = 0O | B outline | ] Properties %

i mipi_dsi0 MIPI Display (r_mipi_dsi)
Stacks Configuration Generte Project Content 9_mipi_ y (r_mipi_
Settings Property Value
Threads € New Thread ¥ Remove = &) New Stack > == ix tack ~ Common
e S e S Ablino; | Parameter Checking Default (B5)
~ m HAL/Common B i i
k ~ Module g_mipi_dsi0 MIPI Display (r_mipi_dsi)
& g_ioport I/0 Port (r_ioport) P yem— General
4 Azure RTOS ThreadX Port (rm_threadx_port) " Options
v & System Thread Low Power
& Azure RTOS GUIX ® Clock Lane
& » Data Lane
T
- Video Mode
¥ Azure RTOS GUIX Port (rm_guix_port) + Interrupts
Receive Interrupt Enable
® Fatal Error Interrupt Enable
» Physical Lane Interrupt Enable
Y

T T

Video Mode Interrupt Enable

4 g_display Graphics LCD 4 D/AVE 2D Port Interface Seguence Channel 0 Interrupt Enable
(r_gledc) (r_drw) Sequence Channel 1 Interrupt Enable
dsi_seq0 Interrupt Priority Priority 12
@ @ dsi_seq1 Interrupt Priority Priority 12
ry ry dsi_vin1 Interrupt Priority Priority 12
& DJAVE 2D (rdew) dsi_rcv Interrupt Priority Fffomy 12
dsi_ferr Interrupt Priority Priority 12

Priority 12

dsi_ppi Interrupt Priority
@ Callback
Callback Context

4] New Object > %

4 g_mipi_phy0 MIPI
Physical Layer
(r_mipi_phy)

@©

Summary BSP Clocks Pins | Interrupts Event Links | Stacks | Components

Figure 14. Adding MIPI Display module and setting properties

RO1AN7550EU0100 Rev.1.00
Oct.15.24

,{ Page 11 of 46
KENESAS



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.11 Navigate to the Pins tab to see the MCU Pins Configuration. Change P4> P404’s Mode to Output
mode (Initial high) to enable LCD panel backlight.

Tr *[Themostat_GUIX.. X | L€l hal_entry.c L€] system_thread_ent... €] hmi_event_handler.c L.€] temperature_time_... L€] startup.c 1€ main.c = O

(¥]

Pin Configuration Generate Project Content

Select Pin Configuration _J,:‘ Export to CSV file f:j Configure Pin Driver Warnings
‘ RABD1EK ~ Manage configurations... Generate data: | g_bsp_pin_cfg
Pin Selection {= & = |% Pin Configuration . Cycle Pin Group
‘ Type filter text Name Value Link
Symbolic Name DISP_BLEN
v v P4 ~
o Comment
Mode Output mode (Initial High)
v/ P40 -
o Pull up/down None
¥ Hei IRQ None
s Output Type CMOS
:
Drive Capacity L
v P405
e ~ Input/Output
. P404 GPIO
s Pag7
7 P40S
v P409
v P410
s PAT1
7 P412
v pa13 Module name: P404 ke
s Pa14 _—
Port Capabilities: CEU:VIO_D3
Gl < ETHER_MII: ETO_EXOUT

n&

FTHFR RMI- ETA FYOIIT
Pin Function | Pin Number

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 15. Settings PWM Timer properties
o
2.2.12 Save the configuration.xml file. In the FSP Configurator, click ©enerate Project Content {6 gangrate module
support files as configured for this project. Make sure the project is selected in the Project Explorer,

and click to build the project files. It may take a long time to finish building an Azure
RTOS/GUIX project on your PC.

2.2.13 From the source file folder FSP_GUIX_Thermostat accompanying this application note, copy the
Azure RTOS GUIX Studio project folder named guix_studio into e? studio project file tree.

Thermostat GUIX_EK_RASD1_MIPI > Source Q-Themostat,GUIX,EK,RASDLMIPI!configuratiom.xml - &* studio

~ File Edit Source Refactor MNavigate Search Project Renesas Views Run Renesas Al Window Help
N
NS | By &~ o itr v Qv
2230 [¢5 Project Explorer X H % %Y § = B | Themostat GUIX EK RABD1_MIPI] FSP Configuration 3
i |5 Themostat_GUIX_EK_RASD1_MIPI [Debug] | o P e e
4.2.12 4%, Binaries New 2
526 [a!) Includes Go Into
2 New Thread #| Remove |-
6.28 Bra Open in New Window b 5 !
completed_project (2 ra_gen Show In Alt+Shift+W >
€ src B Copy ctisc O Port(ricport)
touch_gt911 (= Debug I g Ty ThreadX Port {rm_threadx_port)
= build =
" *K Delete Delete
= ra_cfg 5 GUIX
- Source >
& script o
0 viove...
G configurationxml
: Rename... F2
=| ra_cfg.tet
¥| Themostat GUIX_EK_RAg L= Import..
(%) Developer Assistance | £ Export...
Renesas FSP >

Figure 16. Copying the Azure RTOS GUIX Studio Project to e? studio

2.2.14 The GUIX Studio project is now in the Thermostat GUIX_EK_RA8D1_MIPI e2 studio project, but the
GUIX project cannot be built by the compiler, so the folder must be removed from the build. In the e?
studio Project Explorer, right-click on “guix_studio” folder and select Resource Configurations >
Exclude from Build... ensure that both the Debug and Release are checked, and click OK.
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The “guix_studio” folder holds the GUIX Studio thermostat project. This folder differs from the GUIX
project’s resource and specification files. Those .c and .h files contain the GUIX project’s pixel maps
and fonts, and they will be generated at a later step and included in the e? studio project build.

@ Themostat_GUIX_EK_RASD1_MIPI/configurationxm! - &? studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
[ ® -4~ e itgr Q-
5 Project Explorer X = : ' é S A, [Themostat_GUIX_EK_RA8BD1_MIPI] FSP Configuration X
v 5 Th tat_GUIX_EK_RASD1_MIPI [Deb . .
W Teshictan SURCHK -MIP [Debug] Stacks Configurat] _——
%», Binaries & Exclude from build m} X
R Includes
@ ra Threads %] | Exclude object(s) from build in the following configurations W
2 ra_gen v & HAL/Common Debug! B
&2 src 4% g_ioport I/O P Release [
(& Debug & Azure RTOS TH
(= build v & System Thread
4 Azure RIOS G
= racfg New > -
= script Go Into =
3% configurat Show In Alt+Shift+W > — [
= fg. -
peegnd iZ] Copy Ctri+C
x| Themostat .
@ Devel Paste Ctrl+V
(2) Developer [
& Delete Delete =
Move...
Rename... F2
Ly Import.
Export Select Al Deselect All
Build Project Ctrl+B i
e
Source > U Cancel
Build Targets > s ——
I Resource Configurations. > Exclude from Build... I l @
Reset to Default [ A
O Runhs > | Reset to Default j I i |

Figure 17. Excluding the guix_studio folder from the build

2.2.15 Open the Thermostat_GUIX_EK_RA8D1_MIPI project folder by right-clicking the e2 studio project
name in the Project folder and selecting “System Explorer,” as shown below.

4F Debug As >
Teamn ¥
Compare With ¥
Restore from Local History...
MISRA-C >
W C/C++ Project Settings Ctrl+Alt+P

Save build settings report
Change Device
A7 Run C/C++ Code Analysis

Ii* System Explorer
Command Prompt

Validate
Configure ¥
Source ¥
Properties Alt+Enter

Figure 18. Selecting System Explorer
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2.2.16 Navigate to the sub-folder “guix_studio > GNU” and double-click on the thermostat.gpx project file
to open it with GUIX Studio. Remember that the GUIX Studio version needs to be v6.4.0.0 or later.

[ Themostat_GUIX_EK_RASD1_GLCD > guix_studio > GNU |

Name Date modified Type
thermostat.gxp 6/27/2024 3:50 PM GUIX Studio |
Open

i Edit with Notepad++
“3 CrowdStrike Falcon malware scan (in progress)
a Classify and protect
& Move to OneDrive
7-Zip >

[F Scan with FortiSandbox
& Share

I Open with... I

Keep using this app

Y GUIX Studio
4

Other options

More apps

Always use this app to open .gxp files

OK

. -

Figure 19. Opening the Project File

2.2.17 The GUIX Studio project is a completed design of the Thermostat GUI application. The next several
steps describe the process to generate the project’s resource application code and integrate the
code files to the e? studio project Thermostat GUIX_EK_RA8D1_MIPI.

|G1 Azure RTOS GUIX Studio 6.4.0.0 - thermostat.gxp — O %)

Project Edit Insert Configure Help

B & B ¥ B8 B [ & @ L £ 2 B O3 G O Q& P &F O

1 Project View = El Theme: "theme_1"

Q thern_wostat & Colors
=] l;l display
E-E3 default_folder T' Fonts
-] Help 23B9C  May 11, 2021 09 & Pixelmaps

#-{_| MainPage
{_| Settings
L-;TH_I Splash
En_l Thermostat

Thermostat - Help

«/> Strings

Fan:
When the fan s set 10 AUTO it will enly turn on when either the healer ar the
VRO N . consitioning unit telc it to

When the fan is set to an it will continue to circulate the air regardless of
[0l whether or not the heater and alr conditioning units are on.

- - System:
] Propertles View = m [f the system is OFF then all heating and cooling units are off If your fan is set

o o OM then it will not shut off when the system is off

When the system is set to COOL the air conditioning unit will turn on when
needed to meet the “Set to” temperature

(BTN nen the system is set to HEAT the heating unit will turn on when needed to
mest the “Se1 10” temperature.

Figure 20. GUIX Studio Thermostat Application View
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2.2.18 The Azure RTOS GUIX Studio project consists of 5 screens, including the Splash, Main Page,
Settings, Thermostat, and Help, from the top to bottom layer:

09:30:00 AM

E Thermostat
Indoor:

23.8° 0

RA Set To:
33.0°C

Fan: System:
(TS e b2 AUTO  OFF

Tuesday 09:30:00 AM

00 AM

C Aug 11 4 R®
Thermostat
: ° Thermostat
Year Month Day Display o
A A AT o 238

2024 AUG 11

vV v Vv

Set Date

09:30:0

Thermostat - Help
Fan:
AUTO Wihen the fan is set 1o AUTO it will only tum on when either the healer or the

air conditicning unit tells it ke,

AN Wihen the tan is set to on it will continue to circulate the air regardiess of
“ whether or not the heater and air conditioning units are on.

System:
IF the system is OFF then all heating and cooling units are off If your fan is set
o O then it will not shut off whean the system i ofl
Whien the systam is set to COOL the air conditioning unit will turn on when
needed to meet the “Set to” temperature,

H EAT Wiien the system is set to HEAT the heating unit will turn on when nesded to
meet the “Set 1o’ temperature,

Figure 21. Azure RTOS GUIX Studio Project Screens
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2.2.19 Click on the GUIX Studio option Configure > Project/Display and confirm the following settings.

{2} Configure Project x

Directories

Source Files | ..[../srcfguix_gen | browse...
Header Files | -.f../srcfguix_gen | browse...
Resource Filed | «.f..fsrcfguix_gen | T

Target CPUl Renesas RA

A Advanced Settings

Toolchain | GNU

~ | [ ]big endian

Additional Headers |

| [ ]insert Before

Number of Displays

[+ B

GUIX Library Version E : : E : E :

Major Minor  Patch
Display Configuration
Display Number E = Hame | display |
x resolution pixels y resolution pixels
(1 bpp grayscale 1:5:5:5 forma
=l invert polarity 4:4:4:4 format
(O4bpp
e bpp reverse byte order 3:3:2 format
()16 bpp packed format
[allocate canvas memory Rotation: | cw W
(D32 bpp
8
Cancel Save

Figure 22. Configure Project Settings

2.2.20 Go back e?studio project (Thermostat GUIX_EK_RA8D1_MIPI), right-click on the project file “src”,
then select New > Folder and create a folder named “guix_gen”.

i Project Explorer X
~ 125 Themostat_GUIX_EK_RASD1_GLCD [Debug]

=R § = O | & mhemost

Build Targets
Resource Configurations

Source

Team
Compare With

Q New Folder

Folder

) Includes .
Bra 5 Create a new folder resource.
‘_l; ra_gen
g
L5 sre. | 1
:mi New > I ™ Project.. Enter or select the parent folder:
o Go Into [& C/C++ Project ‘ Themostat_GUIX_EK_RA8D1_GLCD/src
&ou Open in New Window Bic | Al -
i = ==
& ra) Show In Alt+Shift+W > File from Template v l=> Themostat_GUIX_EK_RA8D1_GLCD [Debug]
& sa [[g) Copy Ctri+C ! Folder = settings
F Dact \ & build
o i CrlsV (@ Class Debug
JLH3€: Delete Delete \h[ Header File & guix_studio
; rTah Source > [& Source File Era
Move... B
o A9 Source Folder & rachy
x| Th Rename... F2 | = ra_gen
D 0e T Example... ‘ & script
Export... [ Other. Ctrl+N = src
Build Project Ctrl+B 43
: A Folder name: Iguix,gen l
Refresh F5
Index > Advanced >>

Cancel

@

pn

Figure 23.

Creating a “guix_gen” in e? studio Project

RO1AN7550EU0100 Rev.1.00

Oct.15.24

RENESAS

Page 16 of 46



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

2.2.21 Confirm “guix_gen” is created before moving to next step.

s ? 2 O

1 Project Explorer X ES Y § B
¥ =% Themostat_GUIX_EK_RASD1_GLCD
T e

= ra_gen

v @8 sic
| hal_entry.c
\€| system_thread_entry.c
= Debug
= build
= guix_studio
(= ra_cfg
= script
l_ﬂ configuration.xml
= JLinkLog.log
=| ra_cfg.tt
= Themostat_GUIX_EK_RABD1_GLCD Debug_Flat.jlink
X Themostat_GUIX_EK_RABD1_GLCD Debug_Flat.launch

() Developer Assistance

Figure 24. Confirming creation of “guix_gen”

2.2.22 In Azure RTOS GUIX Studio, click Project > Generate All Output Files to generate resource files,
header files, and source files of this GUIX design.

JGI Azure RTOS GUIX Studio 6.4.0.0 - thermostat.gxp — m] X
Edit Insert Configure Help
New Project S . Select Export Resources
Open Project Ctrl+O e =
Save Project Ctrl+5 q\i—m & Theme: theme_1
Save Project As Shift+Ctrl+5S Ellﬂd[SP‘EY & Colors
Close Project EHw]theme_1

T Fonts

-|v]color table

Import Project

; [effont table ‘ Il & Pixelmaps
Recent Projects > [ pixelmap table
Generate All Output Files o EHv]languages <[> Strings
Generate Resource Files ~.|w|English
Generate Specification Files
Exit Alt+F4
E£H Properties View - []Specify Resource File Namé
~ [ binary mode generate resource header
Binary Mode File Format
(@) S-Record () Binary Memory Offset:
v

Figure 25. Clicking Generate All Output Files
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2.2.23 Click Generate. If successful, you will see the notification below.

A Notification ®

All Output files have been updated.

OK

Figure 26. All Output Files Updated Notification

2.2.24 All output files are now in “guix_gen” folder.

&5 Project Explorer X E®Y § = 0O

v =% Themostat_GUIX_EK_RASD1_MIPI [Debug]
ﬁp Binaries
(! Includes
Bra
= ra_gen
v B src
¥ [== guix_gen
L& thermostat_resources.c
|ﬂ thermostat_resources.h
L] thermostat_specifications.c
@ thermostat_specifications.h
L] hal_entry.c
|£| system_thread_entry.c

(== Debug

(= build

= guix_studio

= ra_cfg

(= script

ﬁf configuration.xml

&l ra_cfg.ixt

|X] Themostat GUIX_EK_RASD1_MIPI Debug_Flatlaunch
(7) Developer Assistance

Figure 27. Location of Output Files
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2.2.25 From the GUIX project’s Project View window, select the “Splash” screen to note the names given
for the Widget Name and Event Function definitions. These definitions are used to create a screen
and handle it in the e? studio/FSP project. The other windows have similar definitions.

|G Azure RTOS GUIX Studio 6.4.0.0 - thermostat.gxp = ] X
Project Edit Insert Configure Help
O & B ¥ 88 © kL & F b € v 2 B 0 & 0 Q& » X @
1 Project View - & Theme: "theme_1"
15 thermostat & Colors
=L display
=2 default_folder T Fonts
#+ | Help 5
# ] MainPage [l Pixelmaps
[-{ | Settings
&L Splash
7 ] Thermostat
fiE Properties View =
Widget Type window
Widget Id
User Data
Left 0
Top 0
Width 854
Height 480
Border No Border iy
Transparsnt O
Draw Selected O
= May 11, 2024
Accepts Focus
Runtime Allocate | TU es d ay
Normal fill WINDOW FILL ~
Selected fill WINDOW_FILL o R b e s e e e i e e i e e e e s s
Disabled fil WINDOW_FILL v
Template O
Visible At Startup m
Draw Function
Wallpaper SPLASH v
I Tile Wallpaper O

Figure 28. Definitions in the Azure RTOS GUIX Studio Project

2.2.26 From the Source file folder accompanying this application note, copy the files in the 2.2.26 folder to
the e? studio’s src folder and overwrite all files that already exist.

* hmi_event_handler.c
» system_thread_entry.c
» system_thread_entry.h

Build Thermostat GUIX_EK _RA8D1_MIPI project. You will see several warnings, but we will
address them in later steps.

2.2.27 Code highlight: The following example creates a screen based on the Widget Name in the GUIX
project and attaches it to the root window. In this case, it is the “Splash” screen. Refer to
system_thread_entry.c for more details.

/* Create the widget and attached to root window.*/
gx_err = gx_studio_named_widget_create("Splash", (GX_WIDGET *) p_root, (GX_WIDGET **) &p_splash_screen);
if(GX_SUCCESS != gx_err)

APP_ERR_TRAP (FSP_ERR_ASSERTION);
}

Figure 29. Create the Splash screen using GUIX API
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2.2.28 Code highlight: An event function associated with a screen needs to be defined to handle events
on that screen. Refer to hmi_event_handler.c for more details. All event functions are empty at this
point.

Handles all events on the splash screen.

am[in]  widget Pointer to the widget that caused the event
in] event_ptr Pointer to event that needs handling

UINT gx_err = GX_SUCCESS;

return gx_err;

}

Figure 30. Handle the Splash screen events

2.2.29 Get your EK-RA8D1 ready to run the project. Connect the MIPI LCD board to the J58 connector on
EK-RA8D1, as shown below.

- Switch on board SW1-6 for GLCD_OE_L set “ON”
- Switch on board SW1-7 for SDRAM set “ON”.
- All other switches, set to “OFF”

Figure 31. Connecting MIPI LCD Board to Connector of EK-RA8D1
2.2.30 Connect the micro-USB cable end to J10 on the EK-RA8D1 board and the other end to your PC.

Build Project % 7 and start the Thermostat GUIX_EK RA8D1_MIPI Debug_Flat project;
you will see a black screen.
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2.2.31 Follow the code in splashscreen_event() function in hmi_event_handler.c to show The Splash
screen. Build the e? studio project.

switch (event ptr->gx event type)
{
case GX_EVENT SHOW:
g% _err = gx window event process(widget, event ptr);
if (GX SUCCESS != gx err) ({
while (1)
}
break;
default:
g% _err = gx window event process(widget, event ptr);
if (GX SUCCESS !'= gx err) ({
while (1) ;
}
break;
t

Figure 32. Show the Splash screen with GUIX APIs

Please refer to the splashscreen_event function in hmi_event_handler.c in the “2.2.26 ” folder in the AN folder.

2.2.32 Since the project has already been downloaded, press the Play button twice to run the project. You
will see the Splash screen on the LCD panel:

RA

May 11, 2024
Tuesday 09:30:00 AM

Figure 33. Splash Screen View on LCD

3. Using GUIX Widget Timer to Trigger a Screen Transition

3.1 Overview

In this section, you will implement a simple use of the GUIX Widget timer, which triggers a screen
transition.

3.2 Procedural Steps

3.2.1 From the Source file folder accompanying this application note, copy the files in the 3.2.1

folder to the e? studio’s src folder, and overwrite all files that already exist. The contents should include:
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- hmi_event_handler.c

- system_thread_entry.c

- system_thread_entry.h

3.2.2 Code highlight: The following code in the splashscreen_event() function starts a GUIX Widget
timer and triggers a screen transition that hides the Splash screen and shows the Main Page screen.

switch (event ptr->gx event type)
{
case GX EVENT TIMER:
gx system timer stop(widget, 10);
toggle_scgeen(p:mainpage_screen,p_splash_screen);
break;
case GX EVENT SHOW:
gx system timer start(widget, 10 , SPLASH TIMEOUT,
SPLASH_TIMEOUT) ; B B B
gx err = gxX window event process(widget, event ptr):
if (GX_SUCCESS != gx_err) { Bl
while (1) ;
}
break;
default:
gx _err = gx window event process(widget, event ptr);
if (GX SUCCESS != gx err) {
while (1); ;
}

break;

Figure 34. Hide the Splash screen and show the Main Page screen

3.2.3 Build, Download, and Run the project, and you will see the transition from the Splash screen to
the Main Page screen in about 3 seconds.

23.8 °C May 11, 2024 ® 09:30:00 AM

E Thermost

Indoor:

23.818

Set lo:
33.0

Fan: System:
AUTO OFF

Figure 35. Main Page Screen

RO1AN7550EU0100 Rev.1.00 Page 22 of 46
Oct.15.24 RENESAS



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

4. Add Touch Driver to Thermostat_GUIX_EK_RA8D1_MIPI Project

4.1 Overview

In this section, you will add the gt911 touch driver to the project to communicate between the MCU
and the touch control circuitry on the MIPI LCD panel.

4.2 Procedural Steps

4.2.1 Inthe Thermostat GUIX_EK RA8D1_MIPI project, create a folder by right-clicking “src”, then
select New > Folder. Name the folder “touch_gt911” and click Finish to create.

Q Themostat_GUIX_EK_RA8D1_MIPl/ra_gen/main.c - * studio Q New Folder ] X
File Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help
o : Folder .
:&;vé‘&v 9_| w5 - Q- __%/‘
[t Project Explorer X ES Y 8 = O mhemostat GUIX EK RABD1 Mip] reate 2 new folder resource. LJ
¥ =% Themostat_GUIX_EK_RA8D1_MIPI [Debug] 90 !
ﬁﬁ' Binaries 91 UINT ¢ Enter or select the parent folder:
92 err =
s} Includes 93 ‘Themostat_GUlX_EK_RASD'\_MIPIjsr( |
52 ra 9 = i
I 4 if (T =
(2 ra_gen 95 { C
e 96 /4 v 1= Themostat_GUIX_EK_RASD1_MIPI [Debug]
(8 srg - 2 - .
(= settings
= = :
= | New >| O Project... & build
[ Go Into [c] C/C++ Project (= Debug
g Open in New Window ¢ File (= guix_studio
g Show In Alt+Shift+W > File from Template Ea ra
(s [E copy Ctrl+C Iﬁ Folder I Vj racfg
ED = paste Ctrl+V ¢ q L:j e
= b X ass = script
& ot Delele Delete | 1o Header File = src
9 Source bR IS <
o ¢/ Source File
i Move... o ot FoRger Folder name‘i| touch_gt911 I
3 a4 name: L
Eﬂ’ = Rename... F2 L 1
18 cc ™ Example..
y N kJ Advanced >>
> e Import... =
= i Export.. 1 Other.. Ctrl+N
= ra 1T 1
ERL Build Project Cirl+B 114 ® || Cancel
Xl Th I 5 115
Figure 36. Creating New Folder in Thermostat_GUIX_EK_RA8D1_MIPI Project
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4.2.2 Copy the contents of the Source folder Source > “touch_gt911” to the e2 studio project src >
touch_gt911 folder you just made. The contents are the hardware driver files touch_gt911.c and
touch_gt911.h, which interface to the touch IC on the MIPI LCD.

{5 Project Explorer = <:‘=.=L> FRT

* J=% Themostat_GUIX_EK_RA8SD1_MIPI [Debug]
d;-f' Binaries

g

[ri¥ Includes

= ra

= ra_gen
v 2 s

(= guix_gen

Vv = touch_gt911
] touch_gt911.c
[H] touch_gt911.h
€] hal_entry.c

€] hmi_event_handler.c
L¢] system_thread_entry.c
[h| system_thread_entry.h
(= Debug
= build
(= guix_studio
[ ra_cfg
(= script
ivf configuration.xml
| JLinkLog.log
= ra_cfg.but
=| Themostat_GUIX_EK_RABD1_MIPI Debug_Flatjlink
|X] Themostat_GUIX_EK_RASD1_MIPI Debug_Flat.launch

(?) Developer Assistance

Figure 37. Copying files to the e?studio Project

4.2.3 Open the e?studio’s configuration.xml file in the Stacks tab and ensure that the e2 studio view FSP
Configuration is selected. Use the New Thread button to create a Touch Thread with the settings illustrated

below.

,,; #[Themostat_GUIX_EK_RA8D1_MIPI] FSP Configuration X = O gE Outline | (] Properties X
2 ! >
Stacks Conflguratlon Generate Project Content Blowquheed
Settings Property Value
Threads u | Remove = 4| New Stack > v Common
= Touch Thread Stacks -
Vo }:IEAL/CDmmuh - Tirer
& g_ioport I/0 Port (r_ioport) '0 Add stacks to the selected thread by using the 'New Stack’ Trace
42 Azure RTOS ThreadX Port (rm_threadx_port) ¥ toolbar button (above), or by pasting here from the Performance
v & System Thread clipboard RA
4% Azure RTOS GUIX Interrupts
Symbol touch_thread
Name Touch Thread
Stack size (bytes) 4096
Priority 3
Auto start Enabled
Time slicing interval (ticks)| 5
Objects <% | New Object >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 38. Creating Touch Thread
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4.2.4 The image below shows the MIPI interface from the EK-RA8D1 MCU schematic. The pins marked in
red are used for touch panel control on the MIPI LCD board:

* IRQ3 interrupt (DISP_INT = P510) is used to trigger touch events.

* lIC channel 1 (ICC_SDA = P512, ICC_SCL = P511) is used to read and write data via 12C
communication protocol to the touch controller.

* DISP_RST = PAO01 is used to reset the touch controller.

CONNECTION TO EK BOARD

TP4— 1 1 TP15
1 — 1516
L E T =TP17

B 3|
TPTE 1 5.0V 1_=TP18
P8 5.0V 33V 1 i]TPﬂ?
PO 1 3.3V CN1 1.8v T 5TP20

1.8V ERMB8-013-05.0-L-DV-TR
P 4

—

206< MIPI_DLO ; z | MIPI_DL1_P 206<
2C6< @_Mlm DlON__* 5 3 8 [ = MIPI DL1 N @ 206<
7
9

2 (R R : - bRy axs
2C6< 1 12 |
i T - R e — 1)
17 15 16—g T PADT
2E6> DISP_INT 4 17 18 > Py DISP_RST 2C6<  2E6<
| e -
7 19 20 7]

Figure 39. MIPI LCD Pin address

4.2.5 Next from the Pins tab, go to PA > PA01 and set the DISP_RST IRQ (PAO01) with the following
configuration:

4% [Themostat GU.. > | [£] hal_entry.c [€] system_thread.. [€] hmi_event_han.. [ temperature_ti.. [€] touch_thread_. = O
Pin Configuration 0
Generate Project Content
Select Pin Configuration _j_:" Export to CSV file E‘ Configure Pin Driver Warnings
| RABD1 EK ¥ Manage configurations... Generate data: | g_bsp_pin_cfg
Pin Selection = I ﬁz Pin Configuration =2 Cycle Pin Group
‘ Type filter text | Name Value Link
Symbolic Name DISP_RST
v ¥ PA ~
) Comment
Mode Input mode
|~ paoi |
P PA? Pull up/down MNone
g Output Type CMOS
< PAD3 = z
Drive Capacity L
< PAD4
g e wv Input/Output
i PAOT « GPIO
< PADE
< PADT
< PADS
< PADS
< PATD
< PAT1
PA12 8 e
¥ PAI3 Module name: PAOT
i ik - Port Capabilities:  BUS: RD
2 L2els 3 GLCD: LCD_TCONO

Pin Function | Pin Number

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 40. Setting DISP_RST IRQ Pin Configuration
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4.2.6 Back in the Stacks tab, make sure the Touch Thread is selected from the Threads window and use
the New Stack button to add the Input > External IRQ Driver (r_icu) to the Touch Thread.

s;,s *[Themostat_GUIX_EK_RASD1_MIPI] FSP Configuration > = 0|3 Properties X
” : 5 -
ouch Thread
Stacks Conflguratlon Generate Project Content
. - Settings Property
Threads 4| New Thread % | Remove =} — v Common
Touch Thread Stacks —
: F " Al » General
v & HAL/Common ot
= i h = Analog > Timer
.“17; g_ioport I/O Port {r_ioport) '0 Add sltacks to the selected thre Audio > Trace
@ Azure RTOS ThreadX Port (rm_threadx_port) ¥ Stack' toolbar button (above), e Dot " e ——
v @ System Thread from the clipboard. -
@ Connectivity ¥ RA
Azure RTOS GUIX DsP s Interrupts
& Touch Thread Graphics 3 v Thread
| Input > < External IRQ (r_icu) I
Monitoring > L
Motor N Stack size (bytes)
Networking > Priority
Pais 5 Auto start
SR ) Time slicing interval
Objects & j X
]] ¢ | New Object > T )
Storage >
System b4
Timers 2
Transfer >
. § Search..
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Components_

Figure 41. Adding External IRQ Driver on r_icu to Touch Thread

4.2.7 From the Properties window, copy the settings from the image below for the External IRQ (r_icu).

Then Click the yellow arrow « <Unavailable> ” from the Pins row to navigate to the Pins tab and set

P510 as the Input/Output field for IRQ3.

=

15¢ *[Themostat_GUIX_EK_RABD1_MIPI] FSP Configuration X

Stacks Configuration

a0

Generate Project Content

2% Outline | [T Properties

g_int_gt911 External IRQ (r_icu)

Settings Property Value
Threads - £ Common
read: ¢ | New Thread ® | Remove gJ-“twn External IRQ : New Stack > APl Info v :
v & HAu(o;nmon (r_icu) Stacks Parameter Checking Default (BSP)
- & ~ Module g_int_gt911 External IRQ
% g_ioport 1/O Port (r_ioport) = N 1911
48 & g_int_gt911 External IRQ ok g.int g
) % Azure RTOS ThreadX Port (rm_threadx_port) (ricw) Channel 3
v @ System Thread Trigger Rising
& Azure RTOS GUIX ® Digital Filtering Disabled
v @ Touch Thread Digital Filtering Sample Clock] PCLK / 64
| <47 g_int_gt911 External IRQ (r_lcu)l Callback touch_int_callback
Pin Interrupt Priority Priority 12
¢ *[Themostat_GUIX_EK_RA8D1_MIPI] FSP Configuration X =SR] v Pins
IRz
Pin Conflguratlon Generate Project Content
Select Pin Configuration .}" Export to CSV file 3-| Configure Pin Driver Warnings
RA8BD1 EK v Manage configurations.
[4] Generate data: -g_nsp_pfn_dg
Pin Selection - + - _“z Pin Configuration 'J Cycle Pin Group
Name Value Lock Link
Pin Group Selection Mixed
v ~
I%I = RO <D
IR ¥ P510 v Y
Hi Q3 ) 2 | |
IRQ1
IRQ2
+ IRQ3
IRQ4
IRQ5
IRQ6
IRQ7 2 3
IRQ8
IRQ9 Module name: IRQ3
IRQ10 *
<
Figure 42. Settings External IRQ Properties
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4.2.8 Back in the Stacks tab of e2studio, follow a similar procedure as the External ICU (r_icu) module to
add the hardware module Connectivity > 12C Master Driver (r_iic_master) to the Touch Thread and set
the right properties as shown in the images below.

{5} *[Themostat_GUIX_EK_RABD1_MIPI] FSP Configuration X

Stacks Configuration

Threads % | New Thread ® | Remove

' HAL/Common

-+ g_ioport I/O Port (r_ioport)

& Azure RTOS ThreadX Port (rm_threadx_port)
v & System Thread
£ Azure RTOS GUIX

4% g_int_gt911 External IRQ (r_icu)

Objects % | New Object >

Stacks Configuration

Threads =

% | New Thread ® | Remove

[v -:‘ HAL/Common
&£ g_ioport /O Port (r_ioport)
4 Azure RTOS ThreadX Port (rm_threadx_port)
v & System Thread
4 Azure RTOS GUIX
v & Touch Thread
& g_int_gt911 External IRQ (r_icu)
P g_i2c_gt911 12C Master (rji(imas‘ler)]

Objects & New Object > &

5 *[Themostat_GUIX_EK_RA8D1_MIPI] FSP Configuration X

= 0 || 8= outline | [T] Properties X
. Touch Thread
Generate Project Content
Settings Property Value
- ar A | ~ Common
Touch Thread Stacks Al » e
Analog > Timer
4 g int_gt911 Exteral IRQ R g Trace
(r_icu) Bootloader > Performance
Connectivil >| 4 Azure RTOS USBX DFU
@ DsP > @ Azure RTOS USBX HCDC
Gaphics > & Azure RTOS USBX HHID
Input > @ Azure RTOS USBX HPRN a0
Moniosing > @  Azure RTOS USBX HUVC F
Mator %
e 4 Azure RTOS USBX OTG CDC
Bvier & 4 Azure RTOS USBX OTG HID
i , @ Azure RTOS USBX PAUD
Sensor > @  Azure RTOS USBX PCDC
Storage > @ Azure RTOS USBX PHID
System > @ Azure RTOS USBX PMSC
Timers > @ Azure RTOS USBX PPRN
Transfer > & CAN FD Lite (r_canfdlite)
% Search.. 4 12C Communication Device (rm_comms_i2c)
T & 12C Master (r_iic_b_master)
|4 12¢ Master (r_iic_master)
@ 12C Master (r_sci_b_i2c)
= O || 8= outline | [ Properties X
! g_i2c master0 12C Master (r_iic master)
Generate Project Content
Settings Property Value
g_i2c_master0 12C Master €| New Stack > T v Common
(r_iic_master) Stacks - Parameter Checking Default (BSP)
DTC on Transmission and Rece Disabled
& g_i2c_gt911 12C Master (r_iic_master) 10-bit slave addressing Disabled
v Module g_i2c_gt911 12C Master (1
Name g_i2c_gt911
@ Channel 1
a Rate Fast-mode
Custom Rate (bps) 0
57 Add DTF Driver for % Add DTC Dnverrfor Rise Time (ns) 120
Transmission [Optional] Reception [Optionall Fall Time (ns) 120
Duty Cycle (%) 50
Slave Address 0x14
Address Mode 7-Bit
Timeout Mode Short Mode
Timeout during SCL Low Enabled
Callback touch_i2c_callback
Interrupt Priority Level Priority 12
~ Pins
sCL1 P512
SDA1 P511

Figure 43. Adding I12C Master Driver on r_iic_master to Touch Thread
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4.2.9 From the Objects window, use the New Object > Semaphore to add the Semaphore GT911 IRQ
with the symbol g_semaphore_gt911_irq. Set the Initial Count to 0. This semaphore is used in the
gt911 driver to trigger data reading when a touch-panel interrupt occurs.

‘r *[Themostat_GUIX_EK_RABD1_MIPI] FSP Configuration > = g 35 Outline ﬁPmperties x

phore_gt911_irq S I e

Stacks Configuration

Generate Project Content

4% Azure RTOS ThreadX Port (rm_threadx_port)

& g_i2c_gt911 12C Master (r_iic_master)

Settings Property Value
Threads % | New Thread %] Remove [=] g.i2¢_gto11 12C Master % | New Stack > Name Semaphore GT911 IRQ
(r_iic_master) Stacks Symbol g_semaphore_gt911_irq
v HE.IAL/CDmmm Initial count 0
7 g_ioport I/O Port (r_ioport)

~ @ System Thread
4% Azure RTOS GUIX ®

~ @ Touch Thread =
4 g_int_gt911 External IRQ (r_icu)
4 g_i2c_gt911 12C Master (r_iic_master)

% Add DTC Driver for
Transmission [Optional]

% Add DITC Driver for
Reception [Optionall

Objects | 4] New Object >| #_| Remove
@ (g semaphore_gt911_irq Semaphoreil . ohaas
® Mutex
@  Queue

@ Semaphore

< >

Summary | BSP | Clacks Pins | Interrupts | Event Links | Stacks| Components

Figure 44. Adding Touch Semaphore

4.2.10 Now add a second: the Semaphore GT911 12C with the symbol g_semaphore_gt911_i2c. Set the
Initial Count to 0. This semaphore signals the Touch thread when a touch event occurs. The Touch
thread then sends the touch event to GUIX for processing.

{5 *[Themostat_GUIX_EK_RABD1_MIPI] FSP Configuration = B || 5= outline | Properties >

(¥]

Stacks Configuration Generate Project Content

g_new_semaphore0 Semaphore

4% Azure RTOS ThreadX Port (rm_threadx_port)
v & System Thread

42 Azure RTOS GUIX
~ @ Touch Thread

4 g_int_gt911 External IRQ (r_icu)

= g_i2c_gt911 12C Master (r_iic_master)

‘9 g_i2c_gt911 12C Master (r_iic_master)

@

%7 Add DTC Driver for
Transmission [Optional]

%9 Add DTC

Objects

% | New Object > | ®-| Remove

Driver for

Reception [Optional]

@ g semaphore_gt911_irg Semaphore
@ g_semaphore_gt911_i2c Semaphotel

<

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Components

Settings Property Value
Threads 4| New Thread #| Remove [=] g.i2c_gt911 I2C Master 4 | New Stack > Name Semaphore GT911 12C
- ti HAL/CaTon (r_iic_master) Stacks Symbol g_semaphore_gt911_i2c
L s Initial count 0o
% g_ioport I/O Port (r_ioport)

Figure 45. Adding I12C Semaphore
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4.2.11 Use the Add New Object > Event Flags to add the GT911 Event Flags with the symbol
g_event_flags_gt911, as shown below.

, *[Themostat_GUIX_EK_RA8D1_MIPI] FSP Configuration >

Stacks Configuration

Threads % | New Thread % | Remove -]

b ! HAL/Common

4 g_ioport I/O Port (r_ioport)

-i.E Azure RTOS ThreadX Port (rm_threadx_port)
~ @ System Thread

42 Azure RTOS GUIX
~ & Touch Thread

4 g_int_gt911 External IRQ (r_icu)

3 g_i2c_gt911 12C Master (r_iic_master)

=g gE Qutline ijPrupertiEs >

g_new _event flags0 Event Flags

Generate Project Content

Settings
g_i2c_gt911 12C Master % | New Stack >

(r_iic_master) Stacks

& g_i2c_gt311 12C Master (r_iic_master)

@

I T
%7 Add DTC Driver for %" Add DTC Driver for
Transmission [Optional] Reception [Optionall

Objects |<‘.’ New Object | #.| Remove
® g_semaphore_gt911_irqg Semaphore | [BETEAEE
@ g_semaphore_gt911_i2¢c Semaphore & Mutex
|- g_event_flags_gt911 Event Flags I & Queue
@ Semaphore

Property
Name
Symbol

Value

GT911 Event Flags
g_event_flags_gt911

Figure 46. Adding Event Flags
o

4.2.12 In RA Configurator, click ©enerate Project Content {4 ganerate project content.

4.2.13 From the Source file folder accompanying this application note, copy the files in the 4.2.13 folder to
the e? studio’s src folder and overwrite all files that already exist. The contents of 4.2.13 are:

* SEGGER_RTT (folder)
« common_utils.h

* hmi_event_handler.c

* system_api.h

« system_cfg.h

» system_thread_entry.c
» system_thread_entry.h

* touch_thread_entry.c

4.2.14

Code highlight: Review the code below from touch_thread_entry.c which is responsible for

retrieving touch data when a touch IRQ happens and sending information about the touch event to

GUIX for processing.

/* Get touch data from the FT5X@6 */
ft5x06_payload_get (&touch_data);

/* Send touch data*/

if (1 == touch_data.num_points)

gxe.gx_event_payload.gx_event_pointdata.gx_point_x = touch_data.point[@].x;
gxe.gx_event payload.gx event pointdata.gx point v = touch data.point[@].y;

else if (GX_EVENT_PEN_DOWN == gxe.gx_event type) // @suppress("10.2b If statement")

= GX_EVENT_PEN_DOWN;

= GX_EVENT_PEN_UP;

{
gxe.gx_event_type
gx_system event send (&gxe);
}
{
gxe.gx_event_type
gx_system_event_send (&gxe);
¥

Figure 47. Touch control code in touch_thread_entry.c
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4.2.15 All the screens designed in the Azure RTOS GUIX Studio project are now created in
system_thread_entry.c

/* Create the widget and attached to root window.*/

gx_err = gx_studio_named_widget_ create("Splash", (GX_WIDGET *) p_root, (GX_WIDGET **) &p splash_screen);
if(GX_SUCCESS != gx_err)

{

}

APP_ERR_TRAP(FSP_ERR ASSERTION);

gx_err = gx_studio_named_widget_create ("Settings", GX_NULL, (GX_WIDGET **) &p_settings_screen);
if(GX_SUCCESS != gx_err)
{

¥

gx_err = gx_studio_named_widget_create ("MainPage", GX_NULL, (GX_WIDGET **) &p_mainpage_screen);
if(GX_SUCCESS != gx_err)

{

}

APP_ERR_TRAP(FSP_ERR_ASSERTION);

APP_ERR_TRAP(FSP_ERR_ASSERTION);

gx_err = gx_studio_named_widget_create ("Thermostat"™, GX_NULL, (GX_WIDGET **) &p_thermostat_screen);
if(GX_SUCCESS != gx_err)
{

}

APP_ERR_TRAP(FSP_ERR_ASSERTION);

gx_err = gx_studio_named_widget_create ("Help", GX_NULL, (GX_WIDGET **) &p help_screen);
if(GX_SUCCESS != gx_err)

{
APP_ERR_TRAP(FSP_ERR_ASSERTION);
¥
Figure 48. Create all screens defined in the GUIX project
RO1AN7550EU0100 Rev.1.00 Page 30 of 46

Oct.15.24 RENESAS



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

4.2.16 The code is marked in red in hmi_event_handler.c handles touch events when the Thermostat and
Settings buttons are clicked. Refer to hmi_event_handler.c for more details.

o Handles all events on the main screen.[]

UTNT mainpage_event(GX_WTNDOW *widget, GX_FVENT *event_ptr)
{
UINT gx_err = GX_SUCCESS;
switch (event_ptr-»gx_event_type)
{
case GXEVENT_MSG_UPDATE_TEMPERATURE:
/** Update temperature text. */
update_local_ temp_string();
update_text((GX_WIDGET *) widget, ID TEMP_TEXT, g_local_temp_str);
update_text((GX_WIDGET *) widget, ID TEMP_TEXT_ 2, g_local_temp_str);
break;
case GXEVENT_MSG_TIME_UPDATE:
update_time ((GX_WIDGET *) widget, &g _pgui_state);
update_date((GX_WIDGET *) widget, &g gui_state);
break;
case GXEVENT _MSG_FAN TOGGLE:
if (g_gui_state.fan_on)

show_hide_widget((GX_WIDGET *) widget, ID FAN_ICON, 1);
}

else

{
¥

break;

show_hide_widget((GX_WIDGET *) widget, ID FAN_ICON, B);

case GX_SIGNAL(ID_THERMO_BUTTON, GX_EVENT_CLICKED):
/** Shows the thermostat control screen. */
toggle screen (p thermostat screen, p mainpage screen);
break;

case GX_SIGNAL(ID SETTINGS BUTTON, GX_EVENT CLICKED):
/** Shows the settings screen and saves which screen the user is currently viewing. */
toggle_screen (p_settings_screen, widget);
break;

case GX_SIGNAL(ID DAY DOWN, GX_EVENT CLICKED):
/*% Create message to set date. */
p_message-»>msg_id.event b.class code = SF_MESSAGE EVENT CLASS TIME;
p_message->msg_id.event b.code = SF MESSAGE EVENT SET DATE;
g gui state.time.tm_mday -= 1;
time.tm_mday = -1;
p_message->msg_payload.time_payload.time = time;
send_message(p_message);
break;

case GX_SIGNAL(ID BACK BUTTON, GX_EVENT CLICKED):
/** Returns to main screen. */
toggle screen (p_mainpage_screen, widget);
break;

case GX_EVENT_SHOW:
gx_err = gx_window_event process(widget, event ptr);
if(GX_SUCCESS != gx err) {

APP_ERR_TRAP(FSP_ERR_ASSERTION);

}
settings_menu_highlight(widget,ID SETTINGS MEMUITEM NOME);

settings_item_ show (widget, ID SETTINGS_CONTENT_MONE, cur_settings screen);
cur_settings _screen = ID SETTINGS_CONTENT_MNONE;

Figure 49. Handle button events from touch input
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4.2.17 Build, Download, and Run the e?studio project. At this point, you will be able to go back and forth
from the Main Page screen to the Thermostat screen and Settings screen using the Thermostat and
Settings buttons on the Main Page screen and the “Back” button on the other two screens.

08:30:00 AM

May 11, 2024

E Thermost

Indoor:

23.8°C
Soet o

33.0 6

Fan: System:
AUTO OFF

May 11, 2024 ¥ 08:30:00 AM

@ Thermostat

Indoor: 2 3 . 8 oc
System:

Fan:

23.8 °C

<
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A A A

2024

h 2 4 4

May 11, 2024 09:30:00 AM

Thermostat

Month  Day

Display

Set Time

MAY 11

Set Date

May 11, 2024 * 09:30:00 AM

Thermostat - Help

@

When the fan is set to AUTO it will only turn on when either the heater or the
air conditioning unit tells it to.

when the fan is set to on it will continue fo circulate the air regardiess of
whether or not the heater and air conditioning are on

If the system is OFF then all heating and cooling units are off. If your fan is set
to ON then it will not shut off when the system is off.

When the system is set o COOL the air conditioning unit will turn on when
needed fo meet the "Set to” temperature.

‘When the system is set to HEAT the heating unit will turn on when needed fo
meet the "Set to” temperature.

Figure 50. Navigating between the Main Page Screen and the Thermostat Screen

5. Control MIPI LCD Backlight

5.1 Overview

In this section, you will use a PWM output pin of a GPT timer to control the intensity (brightness) of
the LCD backlight.

5.2 Procedural Steps

5.2.1 Inthe LCD board schematics below, the DISP_BLEN signal, which is connected to the P404 on the
RA8D1 MCU, is configured in PWM mode to control the intensity of the backlight display.
BACKLIGHT DRIVER
5.0V IH\GILZSQSCZERZZOM1 1
. LEDA [ouT> 286<
:{33%97634IRT14Z-T :L_B 1 P13 L IBfa:ilggmhi\ typ
2 [N o : p20n ﬂBTPM Vi=128Vip
e O D‘;‘;,UELEN 3 lowen %2 ZBst: : ™ LEDK ] 286>
ks [ =
2200 1. =

Figure 51. MIPI LCD Board Schematic

RO1AN7550EU0100 Rev.1.00 Page 32 of 46

Oct.15.24 RENESAS



Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

5.2.2 To configure P404 in PWM output mode, we first need to disable its current configuration from the
Pins tab of the configuration.xml. Navigate to P4 > P404 and set the Mode to Disabled. Save this
change to the configuration.xml before moving to the next step.

o *[Themostat_.. > Lg touch_thread.. Lc| hal_entry.c ¢ startup.c € main.c L€ gx_widget_ev... |n| system_apih 51 =t (]
Pin Configuration 0
Generate Project Content
Select Pin Configuration J;l Export to CSV file ;__ Configure Pin Driver Warnings
RABD1 EK v Manage configurations. [¥] Generate data: gﬁ:jm_rfg
Pin Selection i= & = |% Pin Configuration =4 Cycle Pin Group
ype filter text Name Value Link
Symbolic Name DISP_BLEN
~ Ports ~
b Comment
o | mode Disabled |
= Pull up/down None
IRQ Mone
P3 )
Output Type MO:
v ¥ P4 =
. Drive Capacity
i e v Input/Output
P404 None
P402
P403
P405 < >
P406
/ PADT Maodule name: paps
P408 Port Capabilities: CEU:VIO_D3
P09 ETHER_MII: ETO_EXOUT
ETHER_RMII: ETO_EXOUT
ol GPT3: GTIOC38
P41 IRQ15: IRQ15-DS
4 P412 RTC: RTCIC2
P43 SCI: CTS1
pat4 SDHIT: SD1DATZ
4 SSIED: SSIWSD

Pin Function | Pin Number

Summary | BSP Clocks | Pins Interrupts | Event Links Stacks Components

Figure 52. Disabling P404 in Pin Configuration

5.2.3 still, in the Pins tab, navigate to the Timers:GPT > GPT3. Set the Pin Group Selection to Mixed,
Operation Mode to GTIOCA or GTIOCB, and then set the Input/Output of GTIOCB to P404 as shown in the
image below:

.\,J *[Themostat_.. > | €] touch_thread... L€] hal_entry.c L€ startup.c L€l main.c L€] gx_widget_ev... [1] system_api.h i = B

Pin Configuration Generate Project Content

Select Pin Configuration [l Export to €SV file [§7] Configure Pin Driver Wamnings

| RABD1 EK ~ Manage configurations... Generate data: | g_bsp_pin_cfg

Pin Selection

+ [= % Pin Configuration ~J Cycle Pin Group

‘ Type filter text Name Value Lock  Link
A - Pin Group Selection Mixed

e Operation Mode GTIOCA or GTIOCB

T!mers:AGT v Input/Output <D>

v ¢ Timers:GPT GTIOC2A None

g';? GTIOC3B 7 P404 o = ]

GPT2

GPT4

GPT5

GPT6

GPT7

GPT8 < >

GPT9

GPT10

GPT11

GPT12

GPT13
Timers:GPT_OPS
Timers:GPT_POEG
Timers:RTC
Timers:ULPT

Module name: GPT3

Pin Function | Pin Number

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 53. Setting P404 as GPT3 - GTIOCB Output in Pin Configuration
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5.2.4 Navigate to the Stacks tab. Make sure the System Thread is selected in the Threads window and
click on Add New Stack > Timers > Timer, General PWM (r_gpt). Use the image to make sure the settings

in the Properties tab of the newly added GPT module are set correctly for this application.

{8k *[Themostat_GUIX_EK_RASD1_MIPI] FSP Co.. X | [g startup.c [€] main.c [ system_thread_entry.h = O ||B= outline | [ Properties X
i i System Thread
Stacks Con!lguratlon Generate Project Content 4
Settings Property
Threads %] New Thread %] Remove [ v Common
System Thread Stacks Al 5 S (i)
v H;AUCmmmon Analog > Timer
¥ g_ioport I/O Port (r_ioport) = "
o 42 Azure RTOS GUIX e 2 Trace
<= Azure RTOS ThreadX Port (rm_threadx_port) Bootloader & Performance
v System Thread corneciy B RA
Azure RTOS GUIX @ DSP > Interrupts
~ & Touch Thread 7 Graphics > w Thread
47 g_int_gto11 External IRQ (r_icu) R — : - Input > Symbol
4 g_i2c_gt911 12C Master (r_iic_master) W Acure ort (. guix.p Monitoring > Ll
Motor 5 Stack size (bytes)
@ Networking > Prioaty
< P 5 Auto start :
e = e ;
= = Security 5 Time slicing interval (ticks)
> g_display Graphics LCD Fil Srear 5
r_glcdc
: . g ) ( Storage >
Objects %_| New Object > ®_ | Remove @ @ System 5
® g_semaphore_gt911_irg Semaphore . o~ 7 4 Port Output Enable for GPT (r_poeg)
f 1 -l i
® g_semaphore_gt911_i2c Semaphore = T = Transfer > 4 Realtime Clock (r_rtc)
@ g_event_flags_gt911 Event Flags = ?)T;:III;;?:IEH:S:PLSU h ¥ Search.. @ Three-Phase PWM (r_gpt_three_phase)
- - I“’ Timer, General PWM (r_gpt)
@ @ 4 Timer, Low-Power (r_agt)
Y @ Timer, Ultra-Low-Power (r_ulpt)
_—

,\,_ *[Themostat_GUIX_EK_RA8D1_MIPI] FSP Co.. X | [g] startup.c (€] main.c |ﬂ system_thread_entry.h = EE Outline | =] Properties X

Stacks Configuration Generate Project Content

g_timer_PWM Timer, General PWM (r_gpt)

Objects % | New Object > #_| Remove

@ g_semaphore_gt911_irg Semaphore

Settings Property Value
Threads % | New Thread | Remove [-] % | New Stack > APl Info v Common
AT g_timer PWM Timer, General Parameter Checking Default (BSP)
= i L/Common . ENINXEore)S ek Pin Output Support Enabled
1; g_ioport I/O Port (r_ioport) Write Protect Enable Disabled
> Azure RTOS ThreadX Port (rm_threadx_port) @ g timer PWM Timer ~ Module g_timer_PWM Timer, General F
v & & 3 G
= sttem Thisad General PWM (r_gpt) v General
4 Azure RTOS GUIX Compare Match
'9 _timer_PWM Timer, General PWM (r_gpt) Name _timer_PWM
g _gp [6)) g
~ & Touch Thread Channel 3
& g_int_gt911 External IRQ (r_icu) Made Saw-wave PWM
@ g_i2c_gt911 12C Master (r_iic_master) Period 0x50000
Period Unit Nanoseconds
v Qutput

Custom Waveform
Duty Cycle Percent (only appll(
GTIOCA Qutput Enabled False

GTIOCA Stop Level
GTIOCB Qutput Enabled

Pin Level Low

True

GTIOCB Stop Level Pin Level Low
@ g_semaphore_gt911_i2c Semaphore Input
@ g_event_flags_gt911 Event Flags Interrupts
Extra Features
~ Pins
GTIOC3A None
GTioc3s

Figure 54. Adding Timer Driver on r_gpt to System Thread

Even though the duty cycle of PWM output is purposely set to 10% here, it will be changed to 50% later in

the code.

(]
5.25
content.

In RA Configurator, click Generate Project Content 4 saye the configuration.xml and generate project

5.2.6 From the Source file folder accompanying this application note, copy the files in the 5.2.6 folder to

the e? studio’s src folder and overwrite all files that already exist. The contents of 5.2.6 are:
- common_utils.h
- hmi_event_handler.c

- system_thread_entry.c
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- system_thread_entry.h
- brightness.c

- brightness.h

- system_api.h

- system_cfg.h

- touch_thread_entry.c

5.2.7 Code Highlight: The brightness_up() and brightness_down() functions in brightness.c are used to

set the PWM duty cycle, as shown below:

/* Get the current period setting. */
R_GPT_InfoGet(&g_timer_ PWM_ctrl, &info);

/* Calculate the desired duty cycle based on the current period. Note that if the period could be larger than
* UINT32_MAX / 100, this calculation could overflow. */

duty_cycle_count = (uint32_t) ((info.period_counts * brightness)/GPT_PWM_MAX_ PERCENT});

err = R_GPT_DutyCycleSet(&g_timer_PWM_ctrl, duty cycle_count, GPT_IO PIN GTIOCB);

if (FSP_SUCCESS == err)

{

¥

*p_brightness = (uint8_t)brightness;

Figure 55. Function to update the duty cycle during run-time

5.2.8 Code Highlight: Look at gpt_timer_ PWM_Setup() function in system_thread_entry.c, you will see

that brightness (duty cycle of PWM output) is set to 50 percent.

{

static fsp_err_t gpt_timer_PWM_setup(void) // @suppress("8.1b, 8.1f Non-API function naming")

This function is setting up GPT/PWM timer]

fsp_err_t err = FSP_SUCCESS;

J/* Open GPT */

err = R_GPT _Open(&gz_timer PWM ctrl, &g timer PWM cfg);
if(FSP_SUCCESS != err}

{

3

/* Enable GPT Timer */

err = R_GPT_Enable(&z_timer PWM ctrl);
/* Handle error */

if (FSP_SUCCESS != err)

{

¥

J/* Start GPT timer */

err = R_GPT_Start(&g_timer_PWM_ctrl);;
if(FSP_SUCCESS != err)

{

5

return err;

return err;

return err;

/* Set brightness (LCD backlight) level: 50 = (45+5) */
g pui_state.brightness = 45;

brightness up(&g gui state.brightness);

return err;

Figure 56. Setting the duty cycle of PWM output in the System Thread
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5.2.9 Build, Download, and Run the e?studio project. By clicking the Settings button on the Main Page
screen, you can access the Settings screen.

23.8 °C May 11, 2024 * 09:30:00 AM

E Thermost 0 Settings

Indoor:

23.88

Set s !
33. 0

Fan: System:
AUTO | (EES

Figure 57. Settings Button on Main Page Screen

5.2.10 PWM output can be measured on pin P404. Here, the brightness is set to 50%.

Figure 58. PWM Output on P603 at 50% Brightness

5.2.11 Click the “Display” menu on the Settings screen; you can use the “Up” and “Down” buttons to
change the brightness of the LCD backlight.

23.8 °C May 11, 2024 ” 09:30:00 AM

. Thermostat
° Brightness
Display

Set Time

Set Date

Sound

Figure 59. Display on Settings Screen
5.2.12 PWM output was measured on pin P404 after changing brightness to 65%.
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Figure 60. PWM Output on P404 at 65% Brightness

6. Update Date/Time and Temperature

6.1 Overview

In this section, you will enable the RTC controller as a timekeeper and one ADC channel to read the

MCU die’s temperature sensor and use it as the Thermostat temperature data.

6.2 Procedural Steps
6.2.1

and match the image below to set the properties of the new thread.

In the configuration.xml under the Stacks tab, create a New Thread > Temperature Time Thread,

‘,, *[Themostat_.. X Ig startup.c €} main.c

Stacks Configuration

% | New Thread | % | Remove [

[~ ¥ HAL/Common

-';9 g_ioport IO Port (r_ioport)

42 Azure RTOS ThreadX Port (rm_threadx_port)
™ & System Thread

& Azure RTOS GUIX

& g_timer_PWM Timer, General PWM (r_gpt)
~ & Touch Thread

& g_int_gt911 External IRQ (r_icu)

& g i2c gt911 12C Master (r iic_master)
it Temperature Time Thread

Threads

| < >

Objects <] New Object > =

@ g_semaphore_gt911_irq Semaphore
® g_semaphore_gt911_i2c Semaphore
® g_event_flags_gt911 Event Flags

L€l system_threa...

[£] hmi_event_ha.. 8 = O ||B= Outline | [ Properties X

2 New Thread
Generate Project Content
Property
v Commen
General
Timer

Settings
Temperature Time % | New Stack >

Thread Stacks

Add stacks to the selected thread by using the 'New
»  Stack' toolbar button (above), or by pasting here from
the clipboard.

Trace
Performance
RA
Interrupts
v Thread
Symbol
Name
Stack size (bytes)
Priority
Auto start
Time slicing interval (ticks)

Value

temperature_time_thread
Temperature Time Thread
1024

5

Enabled

10

Figure 61. Create Temperature Time Thread
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6.2.2 Make sure the Temperature Time Thread is selected and hit Add New Stack > Timers > Realtime
Clock (r_rtc). Match the r_rtc settings to those in the image below:

v & Temperature Time Thread
| 4 g_rtc Realtime Clock (r_rtc) |

@ g_semaphore_gt911_irq Semaphore
@ g_semaphore_gt911_i2c Semaphore
@ g_event_flags_gt911 Event Flags

Callback
Alarm Interrupt Priority

,,,; #*[Themostat_.. X | [g] startup.c [ main.c L€] system_threa... (€] hmi_event_ha... e = @ gE— Outline | [ Properties X
i i New Thread
Stacks Conhguratlon Generate Project Content
Settings Property Value
Threads 4| New Thread %] Remove [ Temperature Time v Common
Thread Stacks Al > > General
v &' HAL/Common
@ Analog > Timer
% g_ioport /O Port (r_ioport) | Add stacks to the selected threac Ao o Trace
£ Stack’ toolbar button (above), or
) *: AzuraT:TOZ ThreadX Port (rm_threadx_port) o ( ), D 5 Performance
v &
s .:stern e Connectivity > RA
% Azure RTOS GUIX DSP s Interrupts
$ g_timer_PWM Timer, General PWM (r_gpt) Graphics 5 ~ Thread
v & Touch Thread e 5 Symbol temperature_time_thread
4% g_int_gt911 External IRQ (r_icu) EA oo > Name 2 Temperature Time Thread
P 911 12C Master (r_iic_master) Motor 5 Stack size (bytes) 1024
s 5 Priority 5
etworkin
o 4 5 Auto start Enabled
ower Time slicing interval (ticks) 10
Security >
Sensor >
Storage >
S > System >
_ " ers > |4 port Output Enable for GPT (r_poeg)
ClEEEE e Transfer 3 I ‘9 Realtime Clock (r_rtc)
@ g_semaphore_gt911_irq Semaphore ¥ Search.. @ Three-Phase PWM (r_gpt_three_phase)
@® g_semaphore_gt911_i2c Semaphore 4 Timer, General PWM (r_gpt)
@ g_event_flags_gt911 Event Flags & Timer, Low-Power (r_agt)
4 Timer, Ultra-Low-Power (r_ulpt)
i2F *[Themostat_.. X | [g startup.c [€] mainc L€] system_threa... [ hmi_event_ha.. b = gE— Outline | [] Properties X
Stacks Configuration < g_rtc0 Realtime Clock (r_rtc)
Generate Project Content
Scttings Property Value
Threads % | New Thread .| Remove [ g_rtc0 Realtime Clock 4| New Stack » e ~ Common
B HALC (r_rtc) Stacks Parameter Checking Default (BSP)
v o =
= e L/V ommon y Set Source Clock in Open Disabled
ﬂ; g_foport IO Port (r_iopart) 4 g_rtc Realtime Clock v Module g_rtc0 Realtime Clock (r.
) 4 Azure RTOS ThreadX Port (rm_threadx_port) (l’il‘tCJ Name g.ric
v & System Thread Clock Source LOCO
4% Azure RTOS GUIX @ Frequency Comparision Value| 255
$ g_timer_PWM Timer, General PWM (r_gpt) Automatic Adjustment Mode| Enabled
~ & Touch Thread Automatic Adjustment Period| 10 Seconds
4 gint_gt911 External IRQ (r_icw) Adjustment Type (Plus-Minus) NONE
4 g_i2c_gto11 12C Master (r_iic_master) Error Adjustment Value 0

time_update_callback
Disabled

Period Interrupt Priority Priority 9
Carry Interrupt Priority Priority 12
~ Pins
RTCICO <unavailable>
< 2 RTCIC1 <unavailable>
7 z RTCIC2 <unavailable>
Objects ] New Object > RTCOUT <unavailable >

Figure 62. Adding RTC Driver on g_rtc to Temperature Time Thread and Setting Properties
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6.2.3 The System Thread is where the temperature value will be read from the ADC. Select the System
Thread in the Threads window and press Add New Stack > Analog > ADC (r_adc). Match the r_adc
settings to those in the image below:

Stacks Configuration

Threads ¢ | New Thread ® | Remove =

& ﬁu’curﬂmun

4% g_joport |/O Port (r_joport)

4% Azure RTOS ThreadX Port (rm_threadx_port)
~ @& System Thread

4 Azure RTOS GUIX

L g_timer_PWM Timer, General PWM (r_gpt)
~ & Touch Thread

42 g_int_gt911 External IRQ (r_icu)

# g_i2c_gt911 12C Master (r_iic_master)
v & Temperature Time Thread

4 g_rtc Realtime Clock (r_rtc)

Objects

@ g_semaphore_gt911_irg Semaphore
@ g_semaphore_gt%11_i2c Semaphaore
@ g_event_flags_gt911 Event Flags

& | Mew Object > » |

4 g adc ADC (r_adc)

@

Generate Project Content

4 | New Stack >
g_adc0 ADC (r_adc) Stacks _

g_adc0 ADC (r_adc)

*[Themostat_.. > | [g] startup.c (€] mainc Lc] system_threa... [ hmi_event ha... A = 0O | B% Outline | [C] Properties %
i i Temperature Time Thread
Stacks Configuration Geitétate Project Contant pe
Settings Property Value
Threads 4| New Thread % | Remove [=| Temperature Time = Fu ~ Common
Thread Stacks T Al > | > General
=
g HuALr'Commos;pD I Analog > % ADC (add)
:: :_lopu;gs . it l[;;:f;l:ml . @ g_rtc Realtime Clock Audio > @ ADC-DMAC Integration (r_adc)
:7 Zur?r lherd rt {rm_threadx_port) (r_ric) Bootloader ’ & Comparator, High-Speed (r_acmphs)
v @ 1 hread i 2
b e Connectivity > & pAC (r_dac)
% Azure RTOS GUIX ) DsP 3 -
& g_timer_PWM Timer, General PWM (r_gpt) Graphics 3y + Thread
~ @ Touch Thread Input o Symbol temperature_time_thread
47 g_int_gra11 External IRQ {r_icu) Monitoring & Name Temperature Time Thread
& g_i2c_gt911 12C Master (r_iic_master) Motor > Stack size (bytes) 1024
& Temperature Time Thread Networking > Priority :
) g_rtc Realtime Clock (r_rtc) Power > Auto start nabiled
Security 5 Time slicing interval (ticks) 10
Sensor »
Storage »
< > System >
Timers ?
Objects < | New Object > | Transfer >
@ g_semaphore_gt911_irg Semaphaore 4 Search.
@ g_semaphore_gt311_i2c Semaphore
| @ g_event_flags_gt911 Event Flags
5} *[Themostat_.. X | [d startup.c £ mainc Le| system_threa... L] hmi_event_ha.. 6 = O || 8= outline [T Properties X

Settings Property Value
~ Common
Abiintc Parameter Checking Default (BSP)
v Module g_adc0 ADC (r_adc)
wv General

Name g_ade

Unit 0

Resolution 12-Bit

Alignment Right

Clear after read On

Mode Continuous Scan

Double-trigger Disabled

v Input
w Channel Scan Mask (channel availabil

Channel 0 o
Channel 1 o
Channel 21 o
Channel 22 o
Channel 23 o
Channel 24 a
Channel 25 o
Channel 26 o
Channel 27 o
Channel 28 =]

| Temperature Sensor |
Internal Reference Voltage m)

Group B Scan Mask (channel availabi

Figure 63. Adding ADC Driver on r_adc to System Thread and Setting Properties
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6.2.4 Use the Objects window button Add New Object Button > Semaphore to add the Timer

Semaphore with the symbol g_timer_semaphore. Set the Initial Count to 0. This semaphore will

trigger the timing between the System Thread and the Temperature Time Thread.

4 ‘.‘ HAL/Common

& g_ioport I/O Port (r_ioport)

47 Azure RTOS ThreadX Port (rm_threadx_port)
v @ System Thread

47 Azure RTOS GUIX

g_adc0 ADC (r_adc) Stacks

@ g_adc ADC (r_adc)

@

5 *[Themostat_.. > | [g startup.c [£] main.c [£] system_threa... [£ hmi_event_ha... 6 = O ||B= outline [T Properties
3 3 f 1
new e0 S re
Stacks Configuration Generate Project Content || 9 EW- phor F
Settings Property Value
Threads % | New Thread | Remove [ % | New Stack > Name Timer Semaphore

Symbol
Initial count

g_timer_semaphore
0

& g_timer_PWM Timer, General PWM (r_gpt)
v & Touch Thread

4% g_int_gt911 External IRQ (r_icu)

4 g_i2c_gt911 12C Master (r_iic_master)
Vv & Temperature Time Thread

-i} g_rtc Realtime Clock (r_rtc)

4 g_adc ADC (r_adc)

< >

| % | New Object >| Remove

Event Flags

Objects

L5

@ g_semaphore_gt911_irq Semaphore .
@ g_semaphore_gt911_i2c Semaphore ®  Mutex

L]

-

@ g_event flags_gt911 Event Flags Queue

Semaphore

@ g_timer_semaphore Semaphore I I

Figure 64. Creating g_timer_semaphore

6.2.5 Use the New Object > Queue to create a System Message Queue with the symbol
system_msg_queue . Give it a Message Size of 16 and a Queue Size of 64, as shown below.

0} *{Themostat_.. > | [d] startup.c [e] main.c l€) system_threa... [e] hmi_event_ha... 75 = O | B= outline | [ Properties

Stacks Configuration g_new_queuel Queue

Generate Project Content

Settings Property
Threads % | New Thread # | Remove - % | New Stack > Name System Message Queue
g_adc0 ADC (r_adc) Stacks
Symbol system_msg_queue

hd ‘: HAL/Commaon
—.g g_ioport I/O Port (r_ioport)
42 Azure RTOS ThreadX Port (rm_threadx_port)

Message Size (Words| 16
Queue Size (Bytes) |64

@ g_adc ADC (r_adc)

v @ System Thread
4% Azure RTOS GUIX ®
% g_timer_PWM Timer, General PWM (r_gpt)
™ & Touch Thread
4% g_int_gt911 External IRQ (r_icu)
& g_i2c_gt911 12C Master (r_iic_master)
v & Temperature Time Thread
P g_rtc Realtime Clock (r_rtc)
4 g_adc ADC (r_adc)

< >

|<‘-’_New0bject>|u Remove

_ @ EventFl
@ g_semaphore_gt911_irg Semaphore ventriags

@ g_semaphore_gt911_i2c Semaphar, R utex
@ g _event flags_gt911 Event Flags

Objects

@ Queue

@ g_timer_semaphore Semaphore ® Semaphore

|® system_msg_gueue Queue |

Figure 65. Creating system_msg_queue Queue
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6.2.6 Use the New Object > Mutex to create a System Mutex with the symbol g_sys_mutex . Disable

the Priority Inheritance.

g_adc0 ADC (r_adc) Stacks

w ;: HAL/Common

& g_ioport /0 Port (r_ioport)

47 Azure RTOS ThreadX Port (rm_threadx_port)
v & System Thread

4 Azure RTOS GUIX ®

'ié g_timer_PWM Timer, General PWM (r_gpt)
~ & Touch Thread

42 g_int_gt911 External IRQ (r_icu)

@ g_i2c_gt911 12C Master (r_iic_master)
v & Temperature Time Thread

@ g_rtc Realtime Clock (r_rtc)

4 g_adc ADC (r_adc)

@ g_adc ADC (r_adc)

< >

Objects 4| New Object >| %] Remove

@ g_semaphore_gt911_irg Semaphor— Event Flags
© gsemaphore_gt11 2 Semapho BB ]

@ Queue

@ g_event_flags_gt911 Event Flags
@ g_timer_semaphore Semaphore @ Semaphore

@ system_msg_gueue Queue
|' g_sys_mutex Mutex |

& *[Themostat_.. > | [d startup.c L] main.c L] system_threa... |€] hmi_event_ha... 5 = O | 5= Outline | [] Properties X
Stacks Configuration 0 g_new_mutex0 Mutex
Generate Project Content
Settings Property Value
Threads % | New Thread %] Remove [= 4| New Stack > Name System Mutex

Symbol
Priority inheritance

g_sys_mutex
Disabled

Figure 66. Creating g_sys_mutex Queue

o

6.2.7 In RA Configurator, click @eneratePreject Content +q save the configuration.xml and generate project

content.

6.2.8 From the Source file folder accompanying this application note, copy the files in the 6.2.8 folder to
the e? studio’s src folder and overwrite all files that already exist. The contents of 6.2.8 are:

- hal_entry.c

- brightness.c

- brightness.h

- common_utils.h

- hmi_event_handler.c

- system_api.h

- system_cfg.h

- system_thread_entry.c
- system_thread_entry.h
- system_time.c

- system_time.h

- temperature_time_thread_entry.c
- touch_thread_entry.c
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6.2.9 Code Highlight: In System Thread, date/time data and temperature data get updated every second.
It then sends out events to trigger GUIX updates. The following is an example of handling
temperature and time update events in the Main Page screen event handler.

= case GXEVENT _MSG_UPDATE TEMPERATURE:

[** Update temperature text. */

update local temp string();

update text((GX _WIDGET *) widget, ID TEMP_TEXT, g local temp str);
update text((GX WIDGET *) widget, ID TEMP_TEXT 2, g local temp str);
break;

= case GXEVENT MSG TIME UPDATE:

update_time ((GX_WIDGET *) widget, &g_gui_state);

update date((GX _WIDGET *) widget, &g gui state);

break;

Figure 67. Update the temperature and time each second

6.2.10 Build, Download, and Run the e?studio project. You will see time and temperature updates every
second.

23.8 °C May 11, 2024 * 109:30:00 AM

E Thermost

Indoor:

23.Bi8

Set Ta
33.0 &

Fan: System:
AUTO NEEE

Figure 68. Time, Temperature on Main Page Screen
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7. Testing and Debugging the Complete Thermostat Project
7.1 Overview

In this section, you will import and run the complete Thermostat project that enables the date and
time settings. Upon the user presses the date and time buttons on the settings screen, a message
will be sent to the system thread to update the date and time; then the system thread will send a
GUIX event to trigger a time display update on screens.

7.2 Procedural Steps

7.2.1 You can try the completed project in the completed_project folder; the project name is
Thermostat GUIX_EK _RA8D1_MIPI. Use the “Rename & Import Existing C/C++ Project into
Workspace” feature of the Import menu in e? studio to do so since you already had a project with
the same in the workspace.

File Edit MNavigate Search Project RenesasViews R | & import . X
Mew Alt+Shift+M > Select \
A
OFIEH Eile Choose import wizard. H
-, Open Projects from File System...
Select an import wizard:
Recent Files > [itype filter text ‘
Close Editor Crl+ W visse
,E Archive File
Close All Editors Ctrl+Shift+W (¥ CMSIS Pack
'L"f Existing Projects into Workspace
Save Ctrl+5S 5} File System
ﬁ Preferences
Save As... () Projects from Folder or Archive
Save All Ctrl+Shift+5 I l=> Rename & Import Existing C/C++ Project into Workspace I
e - . &% Renesas C5+ Project for CA78KOR/CATSKO
Revert ¥ Renesas CS+ Project for CC-RX, CC-RL and CC-RH
" Sample Projects on Renesas Website
Mave... & cfCrr
= Install
Rename... F2 (= Oomph
- - = Run/Debug
Refresh F5 T
Convert Line Delimiters To > = TextMate
= Tracing
Print... Ctrl+P 0L
k‘l‘- Import... | Import i I
2y Export..
Properties Alt+Enter
Switch Workspace ¥
Restart
Exit ® < Back Next > Finish Cancel

Figure 69. Rename & Import Existing C/C++ Project into Workspace on Import Menu
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7.2.2 Once the project is imported, open the configuration.xml, click Generate Project Content, and build
the project. There should be no errors or warnings, and you can hit Run twice to proceed with testing

the application.

&~ |- u |
{5 Project Explorer X == g =
v 125 Themostat_GUIX_EK_RASD1_GLCD

ﬁs} Binaries
[ Includes
Era

(* ra_gen

8 src

(= Debug

= build

= guix_studio
= ra_cfg

> S

pt

JlinkLog.log
=| ra_cfg.txt
| Themostat_GUIX_EK_RA8D1_GLCD Debug_Flatjlink
K| Themostat_GUIX_EK_RA8D1_GLCD Debug_Flatlaunch
() Developer Assistance

Q Themostat_GUIX_FK_RASD1_GLCD/configurationxml - e studio

Eile Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help

it Q-

557 [Themostat_GUIX_EK_RA8D1_GLCD] FSP Configuration X

i.c, startup.c €] main.c = a8

Stacks Configuration Generate Praject Content

Threads %_| New Thread 4| New Stack >

HAL/Common Stacks

v if? HAL/Common
-E g_ioport I/O Port (r_ioport)
42 Azure RTOS ThreadX Port (rm_threadx_port)
& System Thread
4% Azure RTOS GUIX I6) I6)
-ﬁ g_timer_PWM Timer, General PWM (r_gpt)
~ & Touch Thread
& g_touch_irg External IRQ (r_icu)
4 g_i2c_touch 12C Master (r_iic_master)
v & Temperature Time Thread
& g_rtc Realtime Clock (r_rtc)
& g_adc ADC (r_adc)

£ g_ioport 1/0 Port
(r_ioport)

4 Azure RTOS ThreadX
Port (rm_threadx_port)

<

Objects % | New Object >

@ g_i2c_semaphore Semaphore
@ g_touch_semaphore Semaphore
@ g_timer_semaphore Semaphare
@ system_msg_gueue Queue

@ g_sys_mutex Mutex

Summary BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

|1'__ Prablems | B Console X | [T Properties| @ Smart Browser | 5 Smart Manual | 45 Debug
CDT Build Console [Themostat GUIX EK RASD1 GLCD]
Extracting support files...

18:05:27 **** Incremental Build of configuration Debug for project Themostat GUIX_EK RASD1 GLCD ***%

make -r -j12 all

arm-none-eabi-size --format=berkeley "Themostat_GUIX_ EK_RASD1_GLCD.elf"
text data bss dec hex filename

1045484 2628 1875884 2923996 2c9ddc Themostat GUIX_EK_RA8D1_GLCD.elf

18:05:29 Build Finished. @ errors, @ warnings. (took 2s.21@ms)

Figure 70. Project imported, Generate Project Content and Built Project.
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Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

8. Website and Support

Visit the following URLSs to learn about key elements of the RA family, download components and related
documentation, and get support:

RA Product Information EK-RA8D1 - Evaluation Kit for RA8D1 MCU Group | Renesas

RA Product Support Forum renesas.com/ra/forum

RA Flexible Software Package renesas.com/FSP

Renesas Support renesas.com/support
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https://www.renesas.com/en/products/microcontrollers-microprocessors/ra-cortex-m-mcus/ek-ra8d1-evaluation-kit-ra8d1-mcu-group
https://renesas.com/ra/forum
http://www.renesas.com/FSP
https://www.renesas.com/support

Renesas RA Family “‘GUIX Thermostat” for EK-RA8D1 MIPI Display

Revision History

Description

Rev. Date Page Summary

1.00 Oct.15.24 — Initial release
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a

system-evaluation test for the given product.



Notice
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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